Data Migration of an Existing Microsoft
Windows CMS to a new Insight Software 6.3
system White Paper

Table of Contents

Lol [0 Tod oo OSSOSO 3
Y Lo e= U Lo (IR IN o] oo g L OSSOSO 4
Migration support matrix for WOrkgroup/OMAIN ............ccueiviiiiiirieriei et sbe bbb seans et e 5
Migration support MatrixX fOr CIUSIEr CIMS ..ottt sttt b et e e st te st et b e st ereebe st e 6
HP Insight Orchestration SUPPOIT MALMIX........cviiiiiirieieiee et e ettt st e e tesb et et e b eseebesbesbe s essereenenrene 8
SCENATOS NOT SUPPOTLEM ...ttt etttk b btk b bbbk b bbbt b st et beb et bbbt b et 8
REGUITEIMEINES ...ttt ettt et e st b e bt et e e b e e e s e e R £ e E e e Rt eE e b e e 2Rt eE e eReeEeeb e e e m e e Rt eReeeeeEe b e e eneebeabenbeseeseneaneane 9
(2153 (o= Y 0TV I o L=l 11 o OSSOSO 10
Step 1: Choosing the appropriate time for CIMS MIgration ...........ccooooiiiiiiiii e 10
Step 2: Collecting operating system-level user names and passwords from old CMS...........ccccooiiiiieniicnnciene e 10
Step 3: Saving any customer created SCripts OF EXECULADIES ........cc.cviiiiiiicic e 10
Step 4: Creating space for NeW target CIMS SYSTEM .......cviiiiiiiiieecisese ettt se et st esressereane 12
Step 5: Upgrading to version 6.3 or installing migration SOftWare ...........cccceoeveiiiiiiiniiec e 12
Configuring the target CMS fOr MIGration........cccciiiiiiiiiicieie ettt st sb et et reene st e 12
Step 1: Optional. Upgrading memory and firmware on the target CMS SYStEM.........cccceiiiereieniniene e 12
Step 2: Installing and pre-configuring the target CIMS ... 13
Step 3: Installing Insight Software version 6.3 on the target CIMS ..........cooiiiiiiiiiee e 13
Step 4: Launching the console on the target CIMIS ..ottt 13
Exporting the source CMS cONfIUIation ata ...........cooeiiriiiiiiieeee ettt e eas 13
Step 1: Backing up YOUr CMS and QatADASE...........ueveiiiiiiriesieietteeste st e e sttt sasbe e sbe s e s esaabesbessebeaenseseanens 14
Step 2: Optional: Recording key data items to be used for import verification ............ccccoeveriiiiieicesececeese 14
Step 3: Un-deploying the existing Shared ReSOUICE DOMAINS..........ccviiriirierieieiecisiesie e e e aneas 14
Step 4: Reconfiguring Insight Control server deployment ageNtS .........ccoeierieieieiiiiseieee e 14
Step 5: Un-securing communications on the CMS when Insight Dynamics Global Workload Manager (QWLM) is in
TSRS
Step 6: Quiescing running services on the source CMS
Step 7: Prepare the Cluster CMS for running the eXport ULHIEY ..........coooriiiiiii e 15
Step 8: Running the export utility 0n the SOUICE CIMS ........cuiiiiiiiceci et 15
Importing the data t0 the TArgEt CIMIS ...ttt st b e e s e te et e be st et e seeseeteabeseen 19
Step 1: Ensuring the target CMS is prepared for an import OPEration ............ccceiviiieriierierieie e 19
Step 2: Configuring remote database access for the import operation to the target CMS........cccccovvievevevcnciesennn 20
Step 3: Copying saved files 10 the target CIMIS ...... ..ottt et sne 21
Step 4: Prepare the Cluster CMS for running the import ULITITY ..........cccooiiiiiii e 21
Step 5: Running the import utility on the target CIMIS ..ot 22
Parameters applicable only fOr CIUSIEr CIMS ...t 22
ClUSEET CIMS BXAMPIE 1.ttt b et b b e st e be e be s b e b et e seessebeebe s et eseeseetesaesbeean 22

Parameters applicable only for target Cluster CMS with remote database..........c.cccveveviviiicienininescce e 22



Cluster CMS with remote database EXAMPIE........c..oi it 23

NON-CIUSTEr CIMIS EXAMPIE ...ttt ettt ettt et e s e e e e s e eneebeebenbe b eneeneabenbeneen 23

Step 6: Configure Insight Dynamics Global Workload Manager property file..........ccooooiiiieiiiiiiieeeeee 27

Step 7: Post-Import HP Insight Orchestration Configuration ............ccooiviiieiiiiiieii e 27

This step can be skipped, if HP 10 is installed on source and target node at the same path. ..........c..ccoceveveirciiinennn 27

Step 8: Restarting the Insight Software services on the target CMS e ettt aenen 28

(LT[ OO USSR PRRUPRURURPN 28

POSt IMPOIT OPEIAtION TASKS ... ettt ettt ettt e st b ekt s b e b et eneebeebesee b e e eneebesbesbennan

Step 1: Verifying the import on the target CMS.........cccooiiiiiiiiiieiiiee

Step 2: Run data collection in ‘overwrite and append’ mode.................

Step 3: Verifying SMTP settings on the target CMS ...

Step 4: Post-migration steps for Cluster CMS.........ccccoceeviiiiiiiincieiecieens

Step 5: Running daily system identification on the target CMS.............

Step 6: Running managed system setup wizard on the target CMS..........

Step 7: Updating the IP address of CMS in managed blade enclosures

Step 8: Redeploying Shared Resource Domains when using Insight Dynamics Global Workload Manager ............. 34

Step 9: Migrating the Insight Dynamics orchestration users to the corresponding user groups on the target CMS when

using Insight DYNAMICS OFCNESIIALION. .........couiiiiieiei ettt ettt b et b e et et e st e be e eneeneeneebesaeas 34

Step 10: If using Insight Dynamics recovery management, perform the following operations ..............cccccoeeevennnne. 35

Step 11: Reconfiguring Insight Control server deployment agENTS..........ccvieriiieiiiieserieiee e 35

Step 12: Reinstalling and reconfiguring Insight Remote Support

Step 13: Updating DOOKMAIKS .......ccvciiiiiiiiiieec ettt b e bt e st tesbesae s esseseenestesben
FOr MOTE INFOMMALION ...ttt 37
Appendix A: QUIeSCING SErVICES 0N SOUICE CIMS..... ...ttt ettt st sbe e e resneneas 38
APPENdiX B: StOP OFUEE OF SEIVICES ... ettt ettt s et e e be b et e e e st et e ebesbesee e e e eneeresaenean 39

Appendix C: Quick reference of export/import commands for Cluster CMS

Appendix D: Partner Services TOO ........cccoviiriiiieiieieeere e
Partner SErvice CLI USAGE ......ccviviriiieieiiee sttt
STOPPING SEIVICES ..vvvivieviiieitesiei ettt sttt e e re s be st e
STAMTING SEIVICES .vvevvivicveiieite ettt eb et st e e be st sre e

LI 18 o] X LT 1 1T o OSSOSO 44
SCENATIO 1: OUL OF MEIMOIY BITOF ... ettt ettt sttt sttt b et b e e et e bt et e ebe st e b e seemeebeebesee e aneeneanesbeseens 44
Scenario 2: An export error for one or more plugins occurs with a message like “No database connection returned for”
Scenario 3: An export error for one or more plugins occurs
Scenario 4: The export or import includes all products, but only the HP SIM data is required...........cccccocevveereeinnne.
Scenario 5: Invalid drive sSpecCiTICation errOr MESSAJE ... ..o e rrrieiererierteseeeeeee e seeseesee e ereseeseeseeneeneas 45
Scenario 6: Power Management data NOt EXPOIEA...........ooi ittt ee e ene e 45
Scenario 7: Import failure: gWLM Service fails t0 STOP ......c.eiiiiiiiiiiiieee e 46
Scenario 8: Logical servers not activated after IMPOIL...........c.ooiiiiiiieee e 47



Introduction

The Insight Software data migration tools (DMT) provide an easy mechanism to migrate an existing Insight
Software central management server (CMS) from one system environment to another. These tools are
designed to relocate a CMS to a new hosted environment when there is a need to change the underlying
hardware or operating system of the CMS, without losing any of the customized data located on the CMS. The
data migrated to the target CMS environment includes the configuration information such as system
credentials, tasks, collections, licenses, and addresses for supplemental management servers, plus
management database information which includes discovered systems, performance data, and profiles

Migration involves export and import operations. First, the export operation runs on the source CMS, which
generates a large compressed zip file containing configuration data from the existing CMS database. Then, the
import operation decompresses this data and imports it on the new, or target, CMS. The target CMS can be
hosted either on a new system in the infrastructure or on the same system.

From 6.2 releases, data migration supports the Highly Available MSCS Cluster CMS. Steps for Non-Cluster
CMS and Cluster CMS are documented in the same white paper. By default all the steps in the document are
applicable for both, unless explicitly mentioned as Non-Cluster CMS or Cluster CMS.

Note:

HP recommends that a separate server be used for the target CMS. However, you
can use the same server as the source and target CMS when new hardware is not
available; the target CMS must not be a cluster CMS, and the OS needs to be
reinstalled from a 32-bit version to a 64-bit version. You must have a unique
hostname and IP for the target CMS(if it is a cluster).

The migration utility does not copy any program executables or OS level configurations. For example, an OS
username and password is not copied by the migration utility. Therefore, Insight Software v6.3 must be
installed on the target CMS before performing the import. Any existing Insight Software configuration data on
the target CMS is overwritten with source CMS information when the data is imported.

Scenarios where the migration utility applies when moving from an older SQL server version or Windows
Server® version to a newer version include:

e Moving from a 32-bit operating system installation to a 64-bit operating system installation on a new
hardware system.

e Moving from an older 64-bit system to a newer and faster 64-bit system.

¢ Moving from a 32-bit operating system installation to a 64-bit operating system installation on the same
hardware system.

e Moving from a 32-bit operating system installation to a new 32-bit operating system installation on a new
hardware system.



Migration support matrix

Table 1: Insight Software 6.3 DMT support matrix

Supported Versions HP Systems HP Insight HP Insight Dynamics HP Virtual
<Source CMS Version> > <Target | nsight Manager Control Connect
CMS version> Enterprise
Manager

531->6.3 No No No No
60363 No No No No

6.1 > 6.3 Yes No No Yes

6.2 > 6.3 Yes No No Yes
6.3>6.3 Yes Yes Yes Yes

Note:
For HP Insight Control and HP Insight Dynamics, the source version of 5.3.1
maps to HP Insight Control or HP Insight Dynamics version 3.1

Note:

From 6.3, migration utility supports using the source CMS’s hostname\ IP
address for the target CMS, whether we have source/target CMS’s as same
system or different systems. However, HP recommends using different system for
target CMS. Before using the source CMS’s hostname \ IP address for the target
CMS, remove the source CMS from the network to avoid conflict.

Note:
Migration is supported only if source CMS and target CMS operating systems are
with same locale.

For example,

Valid scenario: If source CMS had operating system with Windows 2003 with
Chinese locale then target CMS must be installed with Chinese locale. Apart
from that during migration both source CMS and target CMS operating system
locale must be in Chinese.

Invalid scenario: If source CMS had operating system with Windows 2003 with
Chinese locale and target CMS is installed with English locale then migration is
not supported. Even if target CMS locale is latter changed to Chinese migration is
not supported.




Migration support matrix for workgroup/domain

Table 2: Insight Software 6.3 DMT support matrix for workgroup/domain

Source CMS System Target CMS System Supported
* In Domain * In Domain Yes
In Workgroup In Domain No
In Domain In Workgroup No
In Workgroup In Workgroup No
* Note:
dD:rtT?ai?igration is supported only when source and target CMS are in same

Example: source CMS [ASIAPAC/sourcecms] to target CMS
[ASIAPAC/targetcms].

Table 3: Insight Software 6.3 operating system type (32/64-bit) support matrix for Table 1

Source CMS System Target CMS System
CMS operating system CMS operating system
Components P Ehed P 95y
type type
32-bit operating system
HP Systems Insight Manager / 32-bit operating system
HP Insight Dynamics / HP 64-bit operating system
Insight Control Virtual Connect
Enterprise Manager X X i i
64-bit operating system 64 bit operating system

Data migration is supported from default instance to hamed instance and from named instance to default
instance in the following databases:

o Local Microsoft® SQL Server 2005 Express Edition SP3
o Local Microsoft SQL Server 2008 Express Edition SP1
Microsoft SQL Server 2005 SP3

Microsoft SQL Server 2008 SP2

Microsoft SQL Server 2008 SP1

Microsoft SQL Server 2008 R2



Note:
Data migration is not supported for Oracle® databases.

All Windows® operating systems supported by Insight Software are fully supported in data migration. For
supported operating systems, go to http://www.hp.com/go/insightsoftware/docs.

Note:
Data migration is not supported for Linux or HP-UX CMS operating systems.

Migration support matrix for Cluster CMS

The primary data migration use cases supported for a Cluster CMS are:

o Source Cluster CMS to Target Cluster CMS
Source Non-Cluster CMS to Target Cluster CMS

Table 4: Insight Software 6.3 DMT support matrix for a Cluster CMS

Supported Versions HP Systems HP Insight HP Insight Dynamics

<Source CMS Version> > <Target | Insight Manager Control
CMS version>

531->63 No No No

60->63 No No No
No No No

6.1>6.3

6.2 > 6.3 No No No

6.3 6.3 Yes Yes Yes*



http://www.hp.com/go/insightsoftware/docs�

Table 5: Insight Software 6.3 DMT support matrix for HA Cluster CMS- Workgroup/Domain/Remote Database

Migration Scenario
Same . Different
Target OMS Domain Workgroup to Domain Domain
Source CMS
Standalone IC/IDVSE Cluster IC/IDVSE Yes No No
with SQL DB in same with SQL DB in
server same Cluster
Cluster IC/IDVSE with Cluster IC/IDVSE Yes No No
SQL DB in same Cluster | With SQL DB in
same Cluster
Standalone IC/IDVSE Cluster IC/IDVSE | yg No No
with remote SQL DB with remote SQL
DB
Cluster IC/IDVSE with | Cluster IC/IDVSE | ygq No No
remote SQL DB with remote SQL
DB
Note:
Data migration is not supported, if Target Cluster CMS is configured with
Remote Database.
Table 6: Insight Software 6.3 DMT type (32/64-bit) and database support matrix for a Cluster CMS
Source CMS System Target CMS System
CMS operating
Components system Database CMS operating system type Database
type
HP Systems Insight
Manager / HP Windows Server .
Insight Dynamics / 2003 R2 SQL Server 2005 o ;2?‘;‘:!2 zj“é‘:‘tr joeoritﬁ]z SQL Server 2008
HP Insight Control Enterprise 32-bit Enterprise SP3 P P g Enterprise SP1

Virtual Connect
Enterprise Manager

operating system

system

Note:

If the source CMS Insight Software version is earlier than 6.3, you must upgrade
to 6.3 first and then perform data migration.

For more details about the Cluster CMS, see:

¢ |nstalling and upgrading to HP Insight Software 6.3 on Windows Server 2008 R2 Failover Clusters with

SQL Server 2008 for high availability

e Deploying HP SIM 6.x on MSCS clusters on Windows 2003 with SQL Server 2005 SP3 White Paper

e Deploying HP SIM 6.x on MSCS clusters on Windows 2008 with SQL Server 2005 White Paper
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HP Insight Orchestration support matrix

From 6.3, federated CMS is enabled by default in every new installation. Even a single CMS is installed and configured, federation may
be enabled. Thus, when planning the migration of 10 data, make sure to review table 7 carefully.

In order to check whether Federated CMS is enabled in your environment:

. In CMS, open hpio.properties file located at <Insight_Orchestration_install_directory>\conf

and search for federated.io property.

. If this property is set to true, environment is configured as Federated CMS.

. If this property is set to false, environment is configured for Non-Federated CMS.

Table 7 : Insight Software 6.3 DMT support matrix for Non-Federated CMS/Federated CMS

Source CMS System

Target CMS System

Supported

Remarks

Non Federated CMS

Non Federated CMS

Yes

Non Federated CMS

Federated CMS

No

It is possible to manually disable federated CMS
on the target in order to proceed with migration
Non-federated to non-federated scenario). To do
o, open hpio.properties located at C:\Program
Files\HP\Insight Orchestration\conf and update the
property federated.io to false.

Federated CMS

Federated CMS

Yes

Requires source and target CMS to be configured
with the same FDQN.

Federated CMS

Non Federated CMS

No

If federation does not have secondary CMS’s
Fegistered and only the primary CMS is part of the
federation, federation may be disabled but this
equires HP support to help turn an existing
federated CMS into a non-federated CMS.

Contact HP support for this EA- Pl 45268.This
ill be the case when migrating to an HA
environment.

IMPORTANT:

If the source CMS is an upgrade to CMS 6.3 then the source CMS in “ Non

Federated (Source CMS)to Federated CMS (Target CMS) ” scenario during

migration. In such case manually disable Federated CMS on the target as

mentioned below.

Open hpio.properties located

at C:\Program Files\HP\Insight Orchestration\conf and update the property

federated.io to false.

Scenarios not supported

o The source CMS and target CMS with different locales. For more details refer notes at “Migration support

matrix”

e The Source CMS credential and its database server credential are different from Target CMS credential and
its database server credential



e The source CMS with Insight Software 3.x/6.0 installed and the target CMS with standalone Systems
Insight Manager installed.

o The source CMS with standalone Systems Insight Manager and the target CMS with Insight Control or
Insight Dynamics 3.x/6.0 installed.

e The source CMS as a 64-bit system and the target CMS as a 32-bit system.

e The target CMS system is managed by the source CMS.

e The source and target systems are members of different Windows domains.

e The target CMS and the remote SQL server are members of workgroups.

o The target CMS is the same physical system as the source CMS when the target CMS is a cluster CMS.

¢ HP Insight Dynamics orchestration does not support migration of primary or secondary Federated CMS
when source and target CMS’s have different FQDN’s.

o Data migration is not supported, if Target Cluster CMS is configured with Remote Database.

¢ In 6.3, HP Insight Orchestration released federated CMS support. In 6.3 installations, the federated CMS
will be enabled by default. In HA environment, the federated CMS is not supported, thus, the migration
from a federated primary CMS to a cluster configuration is not supported in 6.3. HP Support can
assist in converting federated CMS to a non-federated CMS and thus enabling a migration to a cluster
configuration (non-federated to non-federated scenario). For further assistance, contact HP support for this
EA: Pl 45268.

For more information on 10 federated CMS, please refer the following link
http://www.hp.com/go/matrixoe/docs

Table 8: Insight Software components that do not support migration

HP Insight software component Notes

HP Insight Remote Support software Remote support data must be re-configured on the target CMS. For
example, all systems requiring remote support must be re-imported.

HP Version Control Repository Manager Uses separate migration tool.
(VCRM)
. Manual steps required are listed in this white paper that assist in
HP Insight Control server deployment migrating RDP jobs and scripts.
(RDP)
HP Insight Vulnerability and Patch Not supported by Insight Software 6.x

Manager software

Requirements

o The import operation can only be performed on a CMS with Insight Software version 6.3. When performing
the import operation, the Administrator must login using the same credentials that were used to install
Insight Software v6.3 on the target CMS.

e The same OS user names and credentials defined for use by Insight Software on the source CMS must also
be defined on the target CMS.

e The target CMS must have a fresh installation of Insight Software 6.3.

o [f Insight Dynamics is installed, you must ensure that you have at least 20GB free space for the export file
on both the source and target CMS. File size might vary, depending on the number of discovered systems
and on the Insight Software products that are installed. The file can be much smaller, 50MB, if just HP SIM
is installed with several hundred systems. If you are using a remote database server, you must have 20GB
(varies based on installed products) space in the temporary directory on the remote database for the import
operation.


http://www.hp.com/go/matrixoe/docs�
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Before you begin

The data migration process enables the target CMS to be hosted on a new system
in the infrastructure or on the existing system after an OS upgrade. In either
instance, critical OS-level information must be configured on the target CMS. HP
recommends for the target CMS to be hosted on a different system. \When hosting
on a different system, the installation and configuration of the OS and the
installation of HP Insight Software on the target CMS must be completed before
exporting data or shutting down the source CMS. Completing these installation
and configuration steps on the target CMS system reduces the total time the CMS
is unavailable for management operations.IMPORTANT:

If, you have customized an application, workflow, or script that asynchronously
issues Insight Software requests, and then you must temporarily disable this
functionality to avoid generating Insight Software requests during the HP Insight
Software/ HP Systems Insight Manager upgrade process.

Step 1: Choosing the appropriate time for CMS migration

The migration might take 2 to 8 hours, depending on the number of systems managed, the number of Insight
Software components being migrated, and whether a separate target CMS host is used. The CMS is not
available for management activities during this migration process, and therefore the configuration of the
managed environment must remain unchanged during the migration process. HP recommends performing the
migration at a time when changing the configuration of the managed environment is not expected or required.
Limited feedback is sent to the command-line interface.

Step 2: Collecting operating system-level user names and passwords from old
CMS
The same operating system user names and credentials defined for use by Insight Software on the source CMS

must also be defined on the target CMS. If domain accounts are used, ensure the target system has joined the
Windows domain.

Step 3: Saving any customer created scripts or executables

The migration utility does not export or import non-HP created scripts or other executables. These files must
be copied to the target CMS after the import operation has successfully completed. Copy the following data to
a safe location that is accessible after the import on the target CMS has completed.

e Custom scripts, executables, or other non-HP Insight Software files created on the source CMS. For
instance, you must save a command-line tool. You must manually copy these files to the same location on
the target CMS after the import completes.

e The Install PSP directory — this directory is created during the initial PSP install task and is found
under the Systems Insight Manager directory. You must manually copy this directory to the System Insight
Manager directory on the target CMS after the import completes.

o Other configurations on the source CMS that are necessary for the execution of script. For instance, a
storage device might contain additional data or repositories, if so, the target CMS must be configured to use
the same or similar storage device. Manually exporting Operations Orchestration (OO) repositories:
Pre-condition:

HP Operations Orchestrations migration is valid only when both HP OO and HP 10 are installed in the
same CMS, migration does not apply to a remote Operations Orchestrations installation.

Moreover, it is necessary to migrate OO repositories when

(1) The user have added custom flows to HP 10 Library (/Library/Hewllet-Packard) in HP Operations
Orchestrations or

(2) If user has modified any existing HP 10 flow in HP Operations Orchestrations or

(3) If user has modified local HP Operations Orchestrations repositories.



Before Export:

1. Sign in to the source CMS with operating system-level administrative privileges. Be sure this is the
same user that installed the Insight Software.

2. Open a command prompt:
a. Navigate to Start menu=>Run.
b. Type cmd, and then click OK. The command prompt window appears.

3. Navigate to <STUDIO_INSTALL_DIR>\tools directory.
4. Run the steps below for each OO repository (a total of 6 repositories listed in the table below)

“repoutil -export -loginurl "https://localhost:16443" -u Admin -p <OO_ADMIN_PASSWORD> -1
<O0_REPOSITORY_DIR> -2 <EXPORT_DIR > -x "/Library/Hewlett-Packard""

Where,
OO_ADMIN_PASSWORD is the OO Administrator password.
OO_REPOSITORY_DIR and EXPORT _DIR are specific to each repository defined below:

Repository OO_REPOSITORY_DIR (the OO | EXPORT _DIR (empty
repository to export) output directory)
Central RasRepo <CENTRAL_INSTALL_DIR>\rasrepo Any empty dir, e.g.:

C:\temp\central_rasrepo

Central backup repo <CENTRAL_INSTALL_DIR>\rcrepo Any empty dir, e.g.:
C:\temp\central_rcrepo

Central Default Local <CENTRAL_INSTALL_DIR>\default\repo | Any empty dir, e.g.:
C:\temp\central_default_local

Studio RasRepo <STUDIO_INSTALL_DIR>\rasrepo Any empty dir, e.g.:
C:\temp\studio_rasrepo

Studio Default Local < STUDIO _INSTALL_DIR>\studiorepo Any empty dir, e.g.:
Repo C:\temp\studio_studiorepo

Studio backup repo < STUDIO _INSTALL_DIR>\default\repo | Any empty dir, e.g.:
C:\temp\studio_defaultrepo

<CENTRAL_INSTALL_DIR> is OO Central installation directory, typically installed at “C:\Program
Files\HP\Operations Orchestration\Central”.

<STUDIO_INSTALL_DIR> is OO Studio installation directory, typically installed at “C:\Program
Files\HP\Operations Orchestration\Studio.”

For example:

For Central Default Public Repository, assume CENTRAL_INSTALL_DIR is “C:\Program
Files\HP\Operations Orchestration\Central”, then OO _REPOSITORY_DIR is “C:\Program
Files\HP\Operations Orchestration\Central\rcrepo” and the export command is:

“repoutil -export -loginurl "https://localhost:16443" -u Admin -p MyOOAdminPassword -1
“C:\Program Files\HP\Operations Orchestration\Central\rcrepo” -2 C:\AnyEmptyDirecotry -X
"[Library/Hewlett-Packard"".

Note:

The safe location is mentioned several times in this white paper. If the source
CMS is to be retained and not used as the target CMS, then the source CMS can
be a safe location. These files can then be copied later directly from the source
CMS. If the same hardware is used for the target CMS as well, then you must
locate some shared storage to be used as the safe location, that can host the copies
of the various customer specific files noted in this white paper.
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Step 4: Creating space for new target CMS system

e Ensure at least 20GB free disk space exists for the export file on both the source and target CMS if Insight
Dynamics is installed. The file size might vary, depending on the number of discovered systems and on the
Insight Software products that are installed. The file can be much smaller, 50MB, if only Systems Insight
Manager is installed with several hundred systems.

o [f there is a remote database server, you must have 20GB space in the temporary directory on the remote
database server for the import operation.

Step 5: Upgrading to version 6.3 or installing migration software

If the target CMS has the Insight Control or the Insight Dynamics suite installed from the Insight Software
DVD version pre 6.3 installed, you must upgrade to Insight Software v6.3 prior to starting the migration
process.

e The Insight Software DVD 3.0 or 3.1 contains Insight Dynamics-VSE v4.1.x, which does not support a
direct migration to the Insight Software v6.3 setup, and therefore must be upgraded to v6.0 first and then to
v6.3. The version of Insight Dynamics that is installed on the source CMS can be verified through the
source CMS console Help—> About menu.

o Upgrade the source CMS to Insight Software v6.3, making sure to include the Insight Dynamics version 6.3
suite. For detailed steps on how to upgrade from 3.x to 6.3, see the Insight Software Installation and
Configuration Guide or the Matrix Update Guide found at http://www.hp.com/go/insightsoftware/docs .

o |f you are migrating Insight Software from a Cluster CMS, follow the instructions in Installing and
upgrading to HP Insight Software 6.3 on Windows Server 2008 R2 MSCS for high availability to upgrade
the source cluster to Insight Software version 6.3.

Note:
Operating system administrative privileges are required for the signed in user on
the source CMS.

Configuring the target CMS for migration

To avoid a loss of data, complete the steps defined in the Exporting the source CMS configuration data
section before proceeding with the setup process for the target CMS.

If the source CMS uses a remote database, then the data from the remote database is extracted as part of the
export process. After the export operation has completed, the remote database can then be reconfigured for
use with the target CMS.

IMPORTANT:

If the target CMS is to be the same physical system as the source CMS, you must
complete the export process on the CMS before installing and configuring the
target CMS.

Note:
The target CMS cannot be the same physical system as the source CMS when the
target CMS is a cluster CMS.

Step 1: Optional. Upgrading memory and firmware on the target CMS system

Verify hardware requirements for Insight Software 6.3 at http://www.hp.com/go/insightsoftware/docs and ensure
the new CMS is properly configured.
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Step 2: Installing and pre-configuring the target CMS

1. Install a supported version of Windows operating system that meets Insight Software requirements
on the target CMS.

The target system must not have the UTC system time set earlier than the source. For example, ensure
the system time is synchronized for the source and target CMS.

The target CMS OS must be the same locale as the source CMS. For more details refer notes at
“Migration support matrix”.

The target CMS must either be on the same LAN as the source CMS, or it must have access to all of
the managed systems reachable by the source CMS.

The target CMS must have the same DNS configuration settings as the source CMS. At a minimum,
the target CMS must be able to resolve the same set of forward and reverse DNS lookups supported by
the source CMS.

2. Configure the target CMS with a new host name and IP address, and then add the new host  to the
network at the desired location in the infrastructure. The user can also reuse the source CMS’s host
name and IP address for target CMS. Before reusing the source CMS’s hostname and IP address,
remove the source CMS from the network to avoid conflicts.

3. Using Windows utilities join the Windows domain and configure the set of operating system user
names and passwords on the target CMS, which include all usernames and passwords defined for use
by Insight Software on the source CMS.

4. Ensure the database software is running a version supported by Insight Software v6.3.
Step 3: Installing Insight Software version 6.3 on the target CMS

¢ Only the installation of Insight Software is needed, no additional discovery.
o |f the same remote database server is to be used, either a new instance must be configured or the old
database must be dropped for Insight Software to install.

Follow the instructions in the Insight Software Installation and Configuration Guide, Chapter 2, to install
the same software products that exist on the source CMS. The configuration guide can be found at
http://www.hp.com/go/insightsoftware/docs.

o The post-installation configuration of the target CMS listed in Chapter 3 of the configuration guide do not
have to be performed.

o |f you are migrating Insight Software from a Cluster CMS, follow the instructions in Installing and
upgrading to HP Insight Software 6.3 on Windows Server 2008 R2 MSCS for high availability to upgrade
the source cluster to Insight Software version 6.3. The new cluster must be installed as a different cluster in
the same Windows domain as the old cluster. The steps under Complete and validate the installation do not
have to be performed.

Step 4: Launching the console on the target CMS

Log in to the Systems Insight Manager GUI and verify the expected software is installed through
Help—->About. No additional configuration of the CMS is necessary.

Exporting the source CMS configuration data

Before the export operation can be performed, you must perform several steps to prepare the source CMS,
such as quiescing the Insight Software. If the target CMS and the source CMS are on different servers, to
reduce downtime, Insight Software must be installed on the target CMS prior to exporting the source CMS
configuration data. For additional details, see Before you begin and Configuring the target CMS for migration
in this white paper.

The export operation compresses and encrypts all configuration data related to Insight Software into a single
zip file.

IMPORTANT:

Changes must not be made to the managed environment after an export operation
has been completed. If changes must be made prior to importing, another export
must be run. Insight Software attempts to resynchronize to the environment when
possible.
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Note:
If import cannot be completed and the source CMS must be used again, steps 2,
3, and 4 must be undone. See steps 9 and 12 in the post import operations section.

Step 1: Backing up your CMS and database

This step only applies when the target CMS is the same system as the source CMS.

HP recommends making a new system separate from the source CMS available for the import. However, if
the hardware used for the target CMS is the same as the source CMS, you must back up your CMS and
database as a precaution. If an unexpected error occurs, the CMS and database can easily be restored from the
backup taken.

Before running an export operation, complete the following:

1. Make a full system backup of the source CMS and, if applicable, the remote database.
2. Refer to Appendix A to validate service information.

Step 2: Optional: Recording key data items to be used for import verification

1. View the All Systems system list, and record the total number of systems.

2. Obtain the number of users. Go to Options—> Security—>Users and Authorizations.
3. Count the number of scheduled tasks. Go to Tasks and Logs—>Scheduled tasks.
4

Review the set of collections. Go to the left navigation pane, and select Customize to view all
collections and the details.

Note:

You can use command-line interfaces to validate nodes. For instance, you can
export node lists with mxnode —1¥ and save it. For more information please
refer the following support manual.
http://h20000.www?2.hp.com/bc/docs/support/SupportManual/c01651227/c01651

227.pdf

Step 3: Un-deploying the existing Shared Resource Domains

The required migration pre-export action for g&WLM is to un-deploy all Shared Resource Domains.

Step 4: Reconfiguring Insight Control server deployment agents
This is not applicable to Cluster CMS.

Before shutting down the source CMS, the deployment agents must be reconfigured to interact with the target
CMS. To reconfigure the agents:

1. On the source CMS, select servers from the server deployment console.
Right-click and select Change Agent Settings—>Production Agent.

3. If the source CMS’s host name and IP address is not reused, then Enter the IP address of the target
CMS so that agents can connect to the target CMS.

As the deployment agents on the servers selected previously connect the target CMS, those servers are added
to the deployment console.

If customized deployment jobs exist on the source CMS, then you must export the jobs from the source CMS
for later importing to the target CMS.

To export custom jobs on the source CMS:


http://h20000.www2.hp.com/bc/docs/support/SupportManual/c01651227/c01651227.pdf�
http://h20000.www2.hp.com/bc/docs/support/SupportManual/c01651227/c01651227.pdf�

1. Inthe deployment console, select the jobs for export.

2. Right-click the mouse and then select Export...

3. Specify a name for the exported job file.

4. Copy the exported job file and any customized script files to a safe location.
Note:

The deployment job history for managed computers cannot be migrated. Be sure
to select the desired operating systems when installing server deployment on your
target CMS.

Step 5: Un-securing communications on the CMS when Insight Dynamics
Global Workload Manager (QWLM) is in use

This step can be omitted if the CMS is not being used to manage gWLM nodes.

Unsecure communications on the CMS and all managed nodes if secure communications are in use. Secure
communications must be in the same state [enabled or disabled] for the CMS and all gW LM managed nodes.

To unsecure communications:

1. Select SIM Configure=>1D Agents—>Reset Communications. You are prompted for a list of systems.

2. Provide a complete list of all the managed systems from all Shared Resource Domains (SRDs), either
all at once or SRD by SRD.

Step 6: Quiescing running services on the source CMS

Prior to stopping the Insight Software services, which is required before performing the export operation, the
Insight Software components must be quiesced.

See Appendix A: Quiescing services on Source CMS.

Step 7: Prepare the Cluster CMS for running the export utility
This step is applicable for Cluster CMS only.

o The Insight Software and SQL Server cluster resource groups must be running on the node where the export
utility is to run. Ensure that the other node in the cluster is powered off before running the export utility.

Use Failover Cluster Manager to take the Insight Software cluster resource group offline. Use only the disk,
network name, and IP address resources in the Insight Software group online.

Step 8: Running the export utility on the source CMS

The export utility is a command line interface (CLI) tool that must be run from a standard command prompt
on a Windows operating system. The export utility must be executed by a user that has operating system-level
administrative privileges, and should be the same user that installed the Insight Software on the source CMS.

Note:

If HP Insight Orchestration uses a remote HP Operation Orchestration server then
modify export utility configuration to avoid HP Operation Orchestration
migration. Follow the below steps,

. In the source CMS, open Windows Explorer

. Navigate to <SIM Install Path>\config\migration;

. Remove HPIOP2.xml file from <SIM Install Path>\config\migration
directory.

The export command-line (CLI) syntax is:
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mxexport [-f <Filename>] [-p password]
Where the parameters are listed:

-f—Optional. Can be used to specify a different filename or path for the export archive. The default file name
is Products.zip and is placed in the <SIM Install Path>\data\configdata-export directory -
p—Optional. Enables the password to be passed in on the command line for non-interactive operations such
as a script. This is the password that will be used to encrypt the exported file, Products.zip. If —p is not
specified, the user is prompted to enter the password in a secure fashion. HP recommends not specifying the
password on the command line. The password must be at least 8 characters long and alphanumeric, but should
not be your domain password.

For example:

mxexport —F c:\export.zip —p somepassword

Note:
A file name with spaces is considered a valid file name; for example
my export.zip.

In this example, the compressed file is saved to the root directory of the C: drive and is called export.zip.
Since the password of somepassword was provided, future prompts for the password are not seen.

1. Sign in to the source CMS with operating system-level administrative privileges. Be sure this is the
same user that installed the Insight Software.

2. Open a command prompt:
a. Navigate to Start menu=>Run.
b. Type cmd, and then click OK. The command prompt window appears.

3. Inthe command prompt window, execute the export command:

mxexport

4. A prompt for a Data encryption password appears. Type the password and press Enter. The password
does not appear in clear text.

5. A dialog appears stating All HP Insight Software running services will be stopped. Do you want to
continue? Type Y and press Enter to proceed for migration. If you type N and press Enter, the
migration is aborted.

IMPORTANT:
Record or remember the password because it must be provided during the import
operation.

Note:
Password must have a minimum of eight characters and must be alphanumeric.

Note:

A customized location can be provided to store the exported data. See the “export
parameters”.

Note:

The source CMS must not be rebooted until import is completed. If the source
CMS is rebooted, it restarts the Insight Software services. As a precaution, HP



recommends setting the auto start mode for the services to manual. For the list of
services, see Appendix B: Stop order of services table column Service Display
Name.

After a successful export operation, the default export file, Products.zip, is created in folder “<HPSIM
install Path>\data\configdate-export”. For an example of a successful export operation, see
Figure 1.

Since changes made to the managed environment after the export is done are not part of the exported file, the
source CMS Insight Software services must not be restarted to help ensure that no changes are made from the
source CMS. If changes are made after an export operation, HP recommends rerunning the export utility.
Failure to do so might result with the target CMS being out of sync with the managed environment. The
export operation can be executed multiple times on the source CMS. The export file is overwritten each time
if the same file name is specified.

Note:

If version 6.0 or earlier of HP Insight Software is installed on the source CMS,
services need to be stopped manually. See Data Migration of an Existing MS
Windows CMS to a new Insight Software 6.0 system for a list of services to stop.

Figure 1: Console output of export execution

C:\>mxexport -f Products.zip

Lookup HPSIM InstallPath (x86)

HPSIM InstallPath: C:\Program Files\HP\Systems Insight Manager
Lookup succeeded

Data encryption password:

*

All HP Insight Software running services will be stopped.

Do you want to continue (y/n) ?y

All HP Insight Software services stopped successfully.
Exporting data..

Product Name : HP Insight managed system setup wizard

Product Version : 6.3

Status : Successful
Product Name : HP Insight Global Workload Manager [HP Insight
Dynamics]

Product Version : 6.3

Status - Successful
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Product
Product
Status

Name

Version :

: HP Application Discovery [HP Insight Dynamics]

6.3

: Successful

Product
Product
Status

Name

Version :

Logical Server Management [HP Insight Dynamics]
6.3

: Successful

—————————————————————————————————————————————————————————— Product Name
: HP Insight Capacity Advisor [HP Insight Dynamics]

Product
Status

Version :

6.3

. Successful

Product
Product
Status

Name

Version :

: HP Insight Control power management

6.3

. Successful

Product
Insight

Product
Status

Name

: HP Insight Dynamics infrastructure orchestration [HP

Dynamics infrastructure orchestration]

Version :

6.3.0

. Successful

Product
Product
Status

Name

Version :

: HP Virtual Connect Enterprise Manager

6.3

. Successful

Product
Product
Status

Name

Version :

: HP Insight Control virtual machine management

6.3.0

- Successful

Product
Product
Status

Name

Version :

: HP Insight Control performance management

6.3

- Successful

Product
Product
Status

Name

Version :

: HP Systems Insight Manager

6.3

. Successful

Product

Name

: HP Insight Dynamics infrastructure orchestration -

Auxiliary Data [HP Insight Dynamics infrastructure orchestration]

Product
Status

Version :

6.3.0

- Successful



Product Name : HP Insight Recovery software
Product Version : 6.3
Status - Successful

Product Name : HP Operations Orchestration software [HP Insight
Dynamics infrastructure orchestration]

Product Version : 6.3.0

Status : Successful

Export is successful. The exported data file is C:/Program
Files/HP/Systems Insight Manager/data/configdata-export\Products.zip

C:\>
]

Importing the data to the target CMS

The import utility checks for installed software dependencies and imports the data in a predefined order. As
part of the import operation, some data from the export operation is replaced with data to match the target
system, such as the CMS name and IP address. This enables a migration to a new CMS with a different host
name and IP address. Other environmental changes might occur for the CMS, such as a local or remote
database. The initial installation of the Insight Software on the target CMS configures database connections
and any other local disks and /or file systems needed for the import operation.

After the import process completes, additional manual steps must be performed in order to ensure the
managed environment is consistent with the imported data on the target CMS.

If the new CMS has not been configured and Insight Software is not installed and started on the new CMS
system, perform the steps in the Configuring the target CMS for migration section before proceeding with the
following steps.

Note:
The import operation replaces the configuration data on the system where the
import is done.

Step 1: Ensuring the target CMS is prepared for an import operation

1. Review the “Before you begin”.
2. Ensure the steps in the Configuring the target CMS for migration section have been performed.

3. Ensure the steps in the Exporting the source CMS configuration data section have been performed.

Note:

The target CMS system must not be one of the managed systems on the source
CMS, and instead must be a new system. Deleting the target system from the
source CMS does not work if the target system was ever licensed for any product.

Note:

All the scheduled tasks running in the target CMS must be disabled before the
import operation. After successful import operation, re-enable all the scheduled
tasks in the target CMS.
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Step 2: Configuring remote database access for the import operation to the
target CMS

The following steps must be performed only if the target CMS is configured with a remote SQL server
database. This configuration enables the remote SQL server to have access to import the database information
that is embedded in the export file with the SQL server BCP tools. When the import operation is complete on
the target CMS, remove or disable this file sharing.

Note:

In case target CMS is cluster CMS with remote database, then export zip file
should be placed in custom folder (for example “c:\dmt”) on local drive of target
CMS server instead of configdata-import. For example, in local c: drive
create a folder “dmt” and place the export.zip in it = “c:\dmt\export.zip”. Set
permissions on “dmt” folder similar to configdata-import as mentioned in below
steps.

1. The source CMS, target CMS and the remote SQL server must be in the same Windows domain.
Migration is not supported if they are in workgroups.

2. The folder, configdata-import, under <HPSIM installation directory>\Systems
Insight Manager\data on the target CMS must be shared with full permissions granted to the
database server for the user running the import tool. The share name must be the default,
configdata-import.

Note:
Accessibility of shared folder verification can be done as follow,

For example, if we have target system 15.1.1.20 and remote database system
15.1.1.40. Then “configdata-import” (or custom) directory on target system
should be shared and from remote database system 15.1.1.40 it should be
accessible. Basically “configdata-import” should be accessible when we type the
following URL is explorer \\5.1.1.20\configdata-import™ on remote database
system.

Note:
If you encounter issues during import, set permissions to full control for
Everyone.

3. The SQL service account must be configured to run as a domain user or administrator user that has
access to the configdata- import share named previously.

4. On the target CMS, set folder permissions on the <HPSIM installation
directory>\Systems Insight Manager\data\configdata-import to full control for
authenticatedUsers.

5. The temporary directory, C:\temp, must be present at the remote database server. This directory is
generally provided by the Windows operating system.

6. The xp_cmdshel I must be enabled on the remote database.

a. For SQL 2005, open SQL Surface Area Configuration, select the Database instance used
for the installation, select xp_cmdshel I and click the check box to enable.

b. For SQL 2008, open Microsoft SQL Server Management Studio, select the database
instance used for install, then right click and select Facets. Select Surface area
Configuration from the pull-down box and set XPCmdShellEnabled to true.

Note:
You must disable xp_cmdshel 1 and stop sharing once the import process is
complete.




Note:

The CLI console displays the import operation steps performed for remote SQL
server as shown in Figure 2.

Step 3: Copying saved files to the target CMS

1. Copy the zip file created during the export operation on the source CMS to the target CMS folder
located at <HP SIM Install path>\data\configdata-import. If the export file is placed
in a different location in custom folder (for example, c:\dmt), the location can be specified on the
command line when the import operation is done.

2. Copy the saved scripts and/or custom executables from the safe location ,which has been saved during
“Step 3: Saving any customer created scripts or executables” in the “Before you begin” section to the
target CMS in the appropriate location.

3. Copy the install PSP directory from the safe location to the <siminstalldir>/Install PSP directory on the
target CMS.

4. Manually importing HP Operations Orchestration (OO) repositories:

Pre-condition:
Import OO repositories, if they were exported in source CMS.

Before Import:

Sign in to the source CMS with OS-level administrative privileges. Make sure this is the same
user that installed the Insight Software.
Open a command prompt:

o0 Navigate to Start menu=>Run.

o0 Type cmd, and then click OK. The command prompt window appears.

Navigate to <STUDIO_INSTALL_DIR>\tools directory.

Run  ‘repoutil  -publish  -loginurl  "https://localhost:16443" -u  Admin  -p
<OO_ADMIN_PASSWORD> -1 <DIR_WITH_OO_EXPORTED_DATA> -2
https://localhost:16443 -C r2 -excludepath "/Configuration/Remote Action
Services/RAS_Operator_Path™ -excludepath "/Configuration/System Properties/HpioCmsIP™".

Run the steps below for each OO repository exported in source CMS:

“repoutil -publish -loginurl "https:/localhost:16443" -u Admin -p <OO_ADMIN_PASSWORD> -
1 <OO _EXPORTED DATA DIR> -2 https:i//localhost:16443 -¢  r2  -excludepath
"/Configuration/Remote Action Services/RAS_Operator_Path" -excludepath
"/Configuration/System Properties/HpioCmsIP"".

Where,
OO_ADMIN_PASSWORD is the OO Administrator password.
STUDIO_INSTALL_DIR is the HP OO Studio installation dir.

OO_EXPORTED_DATA DIR is the directory which contains OO repository data exported in
source CMS. In export phase each repository was exported to one directory, hence replace
OO_EXPORTED_DATA DIR with each of the directories provided as EXPORT_DIR in
export phase. For instance, if Central default public repository was exported to
C:\temp\central_ DPR and this directory is available in target CMS, then the correspondent
import command for default public repository is ‘repoutil -publish -loginurl
"https://localhost:16443" -u Admin -p MyOOAdminPassword -1 “C:\temp\central DPR” -2
https:/localhost: 16443 -C r2 -excludepath "/Configuration/Remote Action
Services/RAS_Operator_Path" -excludepath "/Configuration/System Properties/HpioCmsIP"".

Step 4: Prepare the Cluster CMS for running the import utility
This step is applicable to Cluster CMS only.
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Prerequisite steps are:

1. The Insight Software and SQL cluster applications must be running on the node where the import
utility will run. Ensure that the other node in the cluster is powered off before running the import
utility.

2. Use Failover Cluster Manager to take the Insight Software cluster application offline. Then bring only
the disk, file server, network name, and IP address resources in the Insight Software application online.

Step 5: Running the import utility on the target CMS

The import utility is a command-line interface (CLI) tool that must be run from a standard command prompt
on a Windows operating system. The import utility must be executed by a user that has operating system-level
administrative privileges, and be the same user who installed the Insight Software on the target CMS. In
addition, if Insight Dynamics Global Workload Manager is installed, the same user must also have SQL
Server administrative rights to the database.

Note:

If HP Insight Orchestration uses a remote HP Operation Orchestration server then
modify import utility configuration to avoid HP Operation Orchestration
migration. Follow the below steps,

. In the target CMS, open Windows Explorer

. Navigate to <SIM Install Path>\config\migration;

e Open HPIOAux.xml file and update the following line FROM:
“<DependentOn>HPIOP2</DependentOn>" TO:
“<DependentOn>Ism</DependentOn>".

. Remove HPIOP2.xml file from <SIM Install Path>\config\migration
directory.

The import CLI command is
mximport [-f<filename>] [-p password]
Where the parameters are listed in the following:

-f—Optional. Can be used to specify a different filename or path for the export archive. The default file name
is Products.zip and is placed inthe <SIM Install Path>\data\configdata-import
directory on the source CMS.

-p—Optional. Enables the password to be passed in on the command line for non-interactive operations such
as a script. This must be the same password that was used to encrypt the exported file. If —p is not specified,
the user is prompted to enter the password. HP recommends not specifying —p on the command line for
greater security.

Parameters applicable only for Cluster CMS

—v—Mandatory. Used to specify the Cluster IP also known as the MSCS cluster virtual server IP address of
target CMS.

—n—Mandatory. Used to specify the Cluster Name/Host Name also known as the Cluster name is the MSCS
cluster virtual server name of the target CMS. If Cluster Name/Host Name is not available then pass Cluster
IP.

Cluster CMS example

mximport —F <File Name> —p <password> —v <Cluster CMS IP> -n <Cluster CMS
Name>

For example, mximport —F c:\export.zip —p somepassword —v {IP address} —n
hpcluster

Parameters applicable only for target Cluster CMS with remote database
—r—Mandatory. Used to specify the Cluster CMS has remote database server.



Cluster CMS with remote database example

mximport —F <File Name> —p <password> —v <Cluster CMS IP> -n <Cluster CMS
Name> -r <true>

For example, mximport —F c:\export.zip —p somepassword —v {IP address} —n
hpcluster —r true

Non-Cluster CMS example
mximport —F <File Name> —p <password>

For example, mximport —F c:\export.zip —p somepassword

In both examples, the export archive file is read from the root directory of the C: drive and is called
export.zip. Since the password was provided, the user is not prompted for the password.

1. Sign in to the source CMS with operating system-level administrative privileges. Be sure this is the

same user who installed the Insight Software.

2. Open a command prompt:

3.

a. Navigate to Start menu—>Run.
b. Type cmd, and then click OK. The command prompt window appears.

In the command prompt window, execute the import command:

mximport

4. A prompt for a Data encryption password appears. Type the password and press Enter. The password

does not appear in clear text.

IMPORTANT:

The password provided must be identical to the one used when the export utility
was run, otherwise the exported file cannot be read.

5. A dialog appears stating Is Database Remote(y/n)? Type Y and press Enter, otherwise type N and press

6.

Enter.

If the database is remote, you are prompted to confirm whether the prerequisite configuration steps
have been followed for remote database access. Type Y if you have performed the steps, or type N if
you have not performed the steps. If you type N, follow the prerequisite steps in Step 2: Configuring

remote database access for the import operation to the target CMS, and then start the import operation
again.

A warning message displays indicating that the import wipes out all data from the database. Enter Y to
continue the import process, or enter N to terminate the import process.

Note:

The import process clears the data on the target system and database before it
actually imports any data into the target CMS.

Figure 2: Console output of import tool operation

C:\>mximport -f Products.zip



24

I-i-I-:-I-:i-:-:-:-: HP Insight Software Data Import Tool Launcher :-:-

Lookup HPSIM InstallPath (x86)
HPSIM InstallPath: C:\Program Files\HP\Systems Insight Manager
Lookup succeeded

Data encryption password:

*

Is database remote (y/n) ? vy

The following steps are needed to perform only if the target CMS is
configured with a remote SQL server database.

1. The source CMS, target CMS, and the remote SQL server must be in the
same Windows domain.

2. The folder, configdata-import, under <HPSIM installation
directory>\Systems Insight Manager\data on the target CMS must be shared
with full permissions granted to the database server for the user running
the import tool. The share name must be the default, configdata-import

3. The SQL service account must be configured to run as a domain user or
administrator user that would have access to the configdata-import share
named above.

4. The xp_cmdshell must be enabled on the remote database.

a. For SQL 2005, open SQL Surface Area Configuration, select the
Database instance used for the installation, select xp_cmdshell and click
the check box to enable.

b. For SQL 2008, open Microsoft SQL Server Management Studio, select the
database instance used for install, then right click and select Facets.
Select "Surface area Configuration®” from the pulldown and set
XPCmdShel lEnabled to true.

Have you followed the above steps (y/n) ? y

All HP Insight Software running services will be stopped.
Do you want to continue (y/n) ? vy

All HP Insight Software services stopped successfully.

WARNING! Import wipes out all data from the database.

Do you want to proceed (y/n): vy



Extracting the zip file C:/Program Files/HP/Systems Insight
Manager/data/configdata-import\Products.zip

Importing data..

Product

Product

Status

Name

Version :

: HP Systems Insight Manager

6.3

. Successful

Product

Product

Status

Name

Version :

: HP Insight Control power management

6.3

. Successful

Product

Product

Status

Name

Version :

: HP Insight managed system setup wizard

6.3

- Successful

Product

Name

Dynamics]

Product

Status

Version :

: HP Insight Global Workload Manager [HP Insight

6.3

> Successful

Product

Product

Status

Name

Version :

: HP Insight Capacity Advisor [HP Insight Dynamics]

6.3

- Successful

Product

Product

Status

Name

Version :

: HP Insight Control performance management

6.3

- Successful

Product

Product

Status

Name

Version :

Logical Server Management [HP Insight Dynamics]

6.3

- Successful

Product

: HP Insight Recovery software
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Product Version : 6.3
Status . Successful

Product Name : HP Operations Orchestration software [HP Insight
Dynamics infrastructure orchestration]

Product Version : 6.3.0

Status : Successful

Product Name : HP Application Discovery [HP Insight Dynamics]
Product Version : 6.3

Status : Successful

Start Vcem postlmport process.

Product Name : HP Virtual Connect Enterprise Manager

Product Version : 6.3

Status : Successful

Product Name : HP Insight Dynamics infrastructure orchestration -
Auxiliary Data [HP Insight Dynamics infrastructure orchestration]

Product Version : 6.3.0
Status . Successful

Product Name : HP Insight Dynamics infrastructure orchestration [HP
Insight Dynamics infrastructure orchestration]

Product Version : 6.3.0

Status = Successful

Product Name : HP Insight Control virtual machine management
Product Version : 6.3.0

Status : Successful

Import is successful.

C:\>




Step 6: Configure Insight Dynamics Global Workload Manager property file

This step can be skipped if you are not using the CMS to manage gWLM nodes. Users of Insight Dynamics
Global Workload Manager must perform several additional steps. For complete information, see the Insight
Dynamics Global Workload Manager 6.3 Users Guide.

1. In multi homed networks, ensure gWLM property
com.hp.gwlm.security.virtualLocalHostName=<SIMvirtualserverIP> in file
~\Virtual Server Environment\conf\gwlmagent.properties has the correct
SIMvirtualserverlP.

Where SIMvirtualserverlP is virtual server IP address of HPSIM.

If <SIMvirtualserver P> is missing or is not HPSIM virtual server IP, add/modify it to be the IP
address of the HPSIM virtual server.

2. Ensure both forward and reverse DNS is setup for Insight Dynamics Global Workload Manager
managed nodes, for example:

a. If DNS does not resolve targets, put entries in the target CMS hosts file located at
~\Windows\System32\drivers\etc\ for Insight Dynamics Global Workload
Manager managed nodes.

b. Put entries in the managed nodes /etc/hosts files for the CMS.

Step 7: Post-Import HP Insight Orchestration Configuration
This step can be skipped, if HP 10 is installed on source and target node at the same path.

The following script should be executed in the target CMS node after importing data successfully.

Fix_sysprep_dmt._pl

The Fix_sysprep_dmt.pl script updates the 10 database entries and updates sysprep references after the
import operation is performed in the target CMS.

Before executing the script, please ensure that,
- Download fix_sysprep_dmt.pl script from
ftp://ftp.hp.com/pub/softlib2/softwarel/pubsw-windows/p395312722/v72832
- SQLCMD Tool installed on the target CMS
- Ausername created in DBMS with access to the 10 database (it can be the same user used
by 10)

Steps to execute Fix_sysprep_dmt.pl intarget CMS after import:

=

Stop the “HP Insight Orchestration” Windows service

Backup the database ‘hpio’ from the source cms sqgl instance

3. Open a command prompt :

o0 Navigate to <Virtual_Server_Environment_install_directory>\lbin.

o Type perl fix_sysprep_dmt.pl [-s SERVER] [-p PORT] [-i
INSTANCE] [-u USERNAME] [-w PASSWORD]

N

If no parameters are supplied, the script assumes local database, default instance and port, and credentials
from logged user.

Where:
- SERVER - Database server
o0 The hostname or IP address of the remote database.


ftp://ftp.hp.com/pub/softlib2/software1/pubsw-windows/p395312722/v72832�
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- PORT - Database server port number
- The port from the database server. Default value is 1433.
- INSTANCE - Database instance
0 The name of the database instance containing the 10 database.
- USERNAME - Database username
0 Username to be used to connect to the database.
- PASSWORD - Database password
0 Username password

0 On successful execution of the script , the following message will be displayed:
= Sysprep references fixed.Fixing sysprep references.
0 In case the fix is not necessary or already executed the following message will be
displayed:
= No conversion is needed because sysprep path did not change.
o0 In case of failures during execution, the following message will be displayed:
= Failure retrieving items from the 10 database table 'LogicalSoftware'.
In this case, review the script log file (hamed.log) that is generated in the
directory from where the script is executed.

Step 8: Restarting the Insight Software services on the target CMS

Note:

If HP Insight Orchestration uses a remote HP Operation Orchestration server then
ensure the remote HP Operation Orchestration server property values are correct.
Follow the below steps,

. In the target CMS, open Windows Explorer

. Navigate to <lO Install Path>\conf

e Open hpio.properties file and make sure the following lines contains the
correct values,

00.host=<IP Address of the remote HP Operation Orchestration server>.

o0o.port=<port of the remote HP Operation Orchestration server>

0o.username=<HP Operation Orchestration username>.

If the target CMS is a Cluster CMS, use Failover Cluster Manager to bring the Insight Software cluster
application online. Otherwise, start all services using the Partner Services Tool as shown in the following
example.

Usage
1. Sign in to the source CMS with operating system-level administrative privileges. Be sure this is the
same user who installed the Insight Software.

2. Open a command prompt:
a. Navigate to Start menu—>Run.
b. Type cmd, and then click OK. The command prompt window appears.

3. Inthe command prompt window, go to the Systems Insight Manager directory and execute the
partnerservice:

partnerservice —start all

See Appendix D: Partner Services Tool.

Start the services in the order listed in Table 9.



Table 9: Start order of services

Start order HP Insight software component Service display name

1 HP Systems Insight Manager HP Systems Insight Manager

2 HP Insight Control virtual machine management HP Insight Control virtual machine
management

3 HP Insight Control server migration HP Insight Control server migration Web
Service

4 HP Insight Control server migration HP Insight Control server migration
Application Service

5 HP Insight Dynamics — VSE Workload Management HP Global Workload Manager Central

for HP Integrity servers Management Server

6 HP Insight Dynamics capacity planning HP Agentless Data Collector Service

7 HP Insight Dynamics capacity planning HP Agentless Collection for Linux Systems

8 HP Insight Dynamics configuration management HP Application Discovery

9 HP Insight Dynamics infrastructure orchestration RSScheduler

10 HP Insight Dynamics infrastructure orchestration RSJIRAS

11 HP Insight Dynamics infrastructure orchestration RSCentral

12 HP Insight Dynamics configuration management HP Extensible Storage & Server Adapter

13 HP Insight Dynamics configuration management HP Storage Provisioning Manager

14 HP Insight Dynamics configuration management HP Logical Server Automation

15 HP Insight Dynamics infrastructure orchestration HP Insight Orchestration

Post import operation tasks

Step 1: Verifying the import on the target CMS

HP recommends logging in to the target (new) CMS to verify the data has successfully migrated. Verification
of some key data on the target CMS can help ensure the migration was successful. If the optional step to
record key data items under the Exporting the source CMS Configuration data section was performed, use the
item counts that were recorded to verify the following after logging in to the target CMS as a user that has
CMS-level administrator privileges. If verification fails, attempt the export and import processes again.

1. Verify that the All Systems list is the same size as the source system.
Verify that users are the same. See Options—> Security—>Users and Authorizations.
Verify that scheduled tasks appear correct. See Tasks and Logs—> Scheduled tasks.

Verify the set of collections. From the left navigation page, select Customize to view all collections
and the details and verify that they appear correct.

Note:

If you have issues activating a Logical Server after the import, see the
Troubleshooting chapter in the HP Insight Virtualization Manager Software with
Logical Server Management User Guide at
www.hp.com/go/insightdynamics/docs.

Step 2: Run data collection in “‘overwrite and append’ mode

After a migration to a new host, run data collection in ‘overwrite’ mode once, then in ‘append’ mode.


http://www.hp.com/go/insightdynamics/docs�

Step 3: Verifying SMTP settings on the target CMS

After a migration to a new host, it is possible that the SMTP configurations might need to be updated. Log
into the CMS console, select Options—> Events—> Automatic Event Handling—>E-mail settings, and then verify
that the SMTP server is correct. If these settings are incorrect, automatic event handling and the emailing of
reports might fail.

Step 4: Post-migration steps for Cluster CMS
This step is applicable only for Cluster CMS.

1. Start the other node in the cluster.

Log in with the service account credentials you provided to the Insight Software Installer, the username,
password, and domain of your cluster. After you have successfully logged in, the HP SIM home page
appears.

3. Navigate to Options—>Protocol Settings—>Global Protocol Settings. The Global Protocol Settings page
appears.

a. Click the Global Credentials link under SNMP. The Global Credentials page appears.

b. Under Sign-in Credentials, verify that the credentials are set to the service account credentials you
provided to the Insight Software Installer on the target CMS, for example, domain\username and
password. Update the credentials as needed.

¢. Ensure that under SNMP Credentials the SNMP Community String is public.
d. Click OK.

4. In HP SIM, navigate to Options—>Protocol Settings>WMI Mapper Proxy. The WMI Mapper Proxy
page appears. The host, which appears, is the WMI Mapper proxy for the source CMS.

a. If WMI Mapper was not installed by the Insight Software Installer on the target cluster, then ensure
that the WMI Mapper proxy is set to the FullyQalifiedDomainName (FQDN) of the host that is
providing this service for the target cluster. This host is not part of the cluster. If the WMI Mapper
proxy is not set to the correct host:

i.  Check the box to select the current host and click Delete.
ii. Click New.

iii. Enter the FQDN of the host that is providing this service for the target cluster. This host is not
part of the cluster.

iv. Verify the port number and adjust as needed.
v. Click OK.

b. If WMI Mapper was installed by the Insight Software Installer on the target cluster, then follow the
steps to configure the WMI Mapper proxy.

i.  Check the box to select the current host and click Delete.

ii. Click New.

iii. Enter the FQDN of the Systems Insight Manager virtual server name in the target cluster.
iv. Verify the port number and adjust as needed.

v.  Click OK.

Note:

After import ,target CMS will have source CMS’s WMI mapper proxy data .if the
user wants to use the WMI mapper proxy data different from the source machine,
then user has to update the WMI mapper proxy data manually.[ie
whbemportlist.xml]

5. Navigate to Options—>Discovery. The Systems Insight Manager discovery page appears.
a. Click the link for Configure general settings under For all automatic discoveries.
b. Inthe list box named Ping exclusion ranges, templates and/or hosts files: add the following items:

i. The Microsoft SQL Server 2008 virtual server IP address of the target cluster (a public network
IP address).



ii. The Microsoft Distributed Transaction Coordinator virtual server IP address of the target cluster
(a public network IP address).

iii. The private network IP address of the target cluster primary node.
iv. The private network IP address of the target cluster secondary node.
HP recommends that the balance of the private network IP address range also be entered. The

private network exists to facilitate the cluster heartbeat. The private network IP address range is
generally not of any use and must be excluded to prevent possible confusion.

v. Click OK.

6. The main HP SIM discovery page appears once more. At the bottom is a list of discovery tasks that
contains the System Automatic Discovery task. Do not run this task. Select it and click Edit.... In the
Ping inclusion ranges... list box to remove all reference to the target cluster private network IP
Addresses. Click Save.

7. Create or update the discovery task for the Systems Insight Manager virtual server.

a. If the source CMS is a Cluster CMS and a “Discover HP SIM virtual server” discovery task is already
configured:

i.  Select and edit the “Discover HP SIM virtual server” discovery task.

ii. Change the system name/IP field to contain the FQDN of the target cluster Systems Insight
Manager virtual server name.

iii. Click the Credentials... button.

iv. The Sign-in tab is selected. Under Use these credentials ensure that the credentials are set to the
service account credentials you provided to the Insight Software Installer on the target CMS, for
example, domain\username and password.

v. Clear the If these credentials fail box.
vi. Click OK.
vii. Click Save to complete.

b. If the source CMS is not a Cluster CMS and a Discover HP SIM virtual server discovery task is not
configured:

i. Click New... to create a new discovery task.
ii. Select Discover a single system.

iii. Inthe Name field enter the task name, for example, Discover HP SIM virtual
server.

iv. Under Schedule, clear the box used to select automatic scheduling.

v. Inthe system name/IP field enter the FQDN of the Systems Insight Manager virtual server
name.

vi. Click Credentials.... button.

vii. The Sign-in tab is selected. Under Use these credentials enter the service account credentials
you provided to the Insight Software Installer on the target CMS, for example,
domain\username and password.

viii. Clear the If these credentials fail box.
ix. Click OK.
X.  Click Save to complete.
8. Run the discovery task just updated.
a. In the discovery task list box, select Discover HP SIM virtual server.
b. Click Run Now.
c. Wait for the task to complete.
9. Verify the discovered virtual server configuration
a. Inthe left pane, click All Systems.

b. Verify that the System Name column includes entries for both the Failover Cluster virtual server and
the Systems Insight Manager virtual server. They may be represented either by their virtual server
name or, IP address.

i. The Server Type of the Failover Cluster virtual server is Cluster.
ii. The Server Type of the Systems Insight Manager virtual server is Server.
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c. Verify that no system of System Type Management Processor is associated with either the Failover
Cluster virtual server or the Systems Insight Manager virtual server.

10. Navigate to Options—>Discovery. The Systems Insight Manager discovery page appears.
11. Create or update the discovery task for the primary and secondary physical servers.
If the source CMS is a Cluster CMS and a Discover physical cluster nodes discovery task is already

a.

confi
ii.
iii.

iv.
V.

Vi.
Vil.
viii.

gured:
Select and edit the Discover physical cluster nodes discovery task.

In the ping inclusion range list box, change the IP addresses to be the IP addresses of the primary
and secondary nodes in the target cluster.

Click the Credentials... button.

The Sign-in tab is selected. Under Use these credentials ensure that the credentials are set to the
service account credentials you provided to the Insight Software Installer on the target CMS, for
example, domain\username and password.

Clear the If these credentials fail box.
Click OK.
Click Save to complete.

If the source CMS is not a Cluster CMS and a Discover physical cluster nodes discovery task is not

confi

i

ii.
iii.
iv.
V.
vi.
Vii.

viii.
iX.
X.

gured:
Click New... to create a new discovery task.
Select Discover a group of systems.
In the Name field enter the task name, for example, Discover physical cluster nodes.
Under Schedule, clear the box used to select automatic scheduling.
In the ping inclusion range list box, enter the IP addresses of the primary and secondary nodes.
Click Credentials...

The Sign-in tab is selected. Under Use these credentials enter the service account credentials
you provided to the Insight Software Installer on the target CMS, for example,
domain\username and password.

Clear the If these credentials fail box.
Click OK.
Click Save to complete.

12. Run the updated discovery task.

In the discovery task list box, select Discover physical cluster nodes.
b. Click Run Now.

¢. Wait for the task to complete. Minor error messages might appear.

13. Inthe left pane, click All Systems. You can find the cluster virtual server name, the Systems Insight
Manager virtual server name, and the cluster nodes in All Systems. Figure 3 is an example of the display.
Your configuration might contain additional systems.

a.



Figure 3: Two node ProLiant cluster after Systems Insight Manager discovery
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14. Click the virtual server name of the Failover Cluster. In Figure 3, it is cms-c2-cluster. The Cluster
Monitor appears. Browse through the tabs and verify the consistency with the same data as shown by
Windows Failover Cluster Manager.

15. To verify that the HP SIM Group resources can be moved between both systems, as in a failover, perform
the following steps from either one of the cluster systems:

a. Inthe left pane of Failover Cluster Manager Window, right-click the HP SIM group. Select Move this
service or application to another node. Be sure that the group fails over to the other system, and that
all of the HP SIM Group cluster resources come online.

b. After waiting a few minutes to ensure that the Systems Insight Manager service has started, connect to
the Systems Insight Manager service through a client Web browser, as done above in Steps 1, 2, and
3.

c. Verify that the following settings configured remain in place;
o  WMI Mapper Proxy
0 SNMP community name and credentials
0 Ping exclusion ranges
o0 Discovery tasks edited
d. Verify the consistency of the All Systems and Cluster Monitor displays.

16. HP SIM Group resources are now owned by the secondary node. Repeat Step 14 to move the HP SIM
Group resources back to the primary node, and then verify the move.

Follow the steps in the Final configuration steps section of Installing and upgrading to HP Insight Software
6.3 on Windows Server 2008 R2 Failover Clusters with SQL Server 2008 for high availability.

Step 5: Running daily system identification on the target CMS
Run the daily system identification task to ensure data is up to date in the target CMS.

1. Inthe CMS console, navigate to Task and Logs—>View All Scheduled Tasks.
2. Select the Daily System Identification task.
3. Click Run.
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Step 6: Running managed system setup wizard on the target CMS

If the source and target systems are running version 6.0 or later of Insight Control or Insight Dynamics, create
a new task, and then run Manage System Setup against all systems.

Note:
MSSW might take a while to run.

Step 7: Updating the IP address of CMS in managed blade enclosures

Virtual Connect Enterprise Manager (VCEM) must update the Virtual Connect Domains with the IP address
of the target CMS.
1. Sign in to the CMS portal to validate that HP SIM has completely restarted.
2. Opena command prompt on the target CMS.
a. Navigate to Start menu—>Run.
b. Type cmd, and then click OK. The command prompt window appears.
3. In the command prompt window, execute the command:
Vcem —uvcm

This command updates all VCEM-managed Virtual Connect Domains to contain the IP address of the
target CMS and displays an informative message on the console.

Note:
VCEM automatically locks to the target CMS after migration.

Note:

If VCEM is to be uninstalled on the source CMS, first edit the registry on the
source CMS, locate the key:
HKEY_LOCAL_MACHINE>SOFTWARE>Hewlett-Packard>Virtual Connect
Enterprise Manager>Settings, and set check\VVCDomain to false

Step 8: Redeploying Shared Resource Domains when using Insight Dynamics
Global Workload Manager

Users of Insight Dynamics Global Workload Manager must perform several additional steps. For complete
information, see the Insight Dynamics Global Workload Manager 6.3 Users Guide.

1. If secure communications are desired, then secure communications between the target CMS and all
managed nodes.

2. Redeploy all previously deployed Shared Resource Domains.

Step 9: Migrating the Insight Dynamics orchestration users to the
corresponding user groups on the target CMS when using Insight Dynamics
orchestration

With the user names and passwords collected before the import operation, create the users on the target CMS.
This step is not required for domain users.

Associate the users with the corresponding Windows User Groups required by Insight Dynamics
infrastructure orchestration:

1. Go to Control Panel>Administrative Tool->Computer Management—>Local Users and
Groups—>Groups.

2. Add the Insight Orchestration Administrator users to the HP1O_Administrators group.



3.
4.

Add the Insight Orchestration Architect users to the HP1O_Architects group.
Add the Insight Orchestration regular users to the HPIO_Users group.

Step 10: If using Insight Dynamics recovery management, perform the
following operations

1.

2.

3.

From the Insight Recovery user interface on the target and remote site CMS, navigate to the Sites tab,
ensure that the CMS name of the target CMS is properly reflected in either the local or remote site
after migration. If any of the CMS names for the local or remote site is incorrect or blank, update the
site with the correct CMS name. Follow the procedure outlined in Chapter 3 of the Insight Dynamics
Recovery Management User Guide for editing a site.

Use the following procedure to refresh the credentials for each EVA Storage Management Server:
a. Navigate to the HP Insight Recovery Storage Management Servers tab.
b. Select an EVA Storage Management Server, and click Edit.
c. Select the Refresh SIM Password box, and then click Save.

Perform a rehearsed failover.

For validation of the migration, HP recommends performing a planned failover as outlined in Chapter 8 of the
Insight Dynamics Recovery Management User Guide.

Note:

HP Insight Dynamics recovery management currently has a limitation that job
information is not migrated to the target CMS. Therefore, the jobs TAB of HP
Insight Dynamics recovery management will be empty after migration.

Step 11: Reconfiguring Insight Control server deployment agents

If you had customized deployment jobs on the source CMS, you must import them to the target CMS. Copy
the exported job files from the safe location and any other customized script files to the target CMS. To
import the customized jobs on the target CMS:

o > w0 D RE

From the deployment console menu, select File=> Import/Export->Import Jobs...

Browse to the local copy of the jobs file that was previously exported from the source CMS.
Select a job folder in which to import the jobs.

Press OK to begin the import process.

Copy any customized deployment script files from the safe location to the appropriate locations on the
target CMS.

If the deployment server is remote, you will need to change the location where HP SIM looks for the
deployment server.

1.

Open a command prompt and run mxnodesecurity —1I to list the deployment server’s IP address.
If this address is correct you can stop here.
To change the IP address used by HP SIM for the deployment server, type the following in the same
command window:
a. mxnodesecurity -r -p dsc_rdp -n rdp-ip to delete the old deployment
server IP address where rdp-ip is the IP address of the deployment server.
b. mxnodesecurity -a -p dsc_rdp -c username:password -n rdp-ip

to add the new deployment server IP back in with the user name and password necessary
to access that server.
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Step 12: Reinstalling and reconfiguring Insight Remote Support

Insight Remote Support Advanced must be reinstalled and reconfigured on the target CMS. For more
information, see the HP Systems Insight Manager 6.3 Installation and Configuration Guide for Microsoft
Windows.

Step 13: Updating bookmarks

1. Notify users that bookmarked URLSs to the source CMS will no longer be valid after migration to the
target CMS.

2. Provide new links to the target CMS, for example https://<newcmsname>:50000.




For more information

Insight Dynamics troubleshooting guides at www.hp.com/go/insightdynamics/docs
Backing up and restoring HP Insight Software v6.3 Central Management System (Windows) white paper at
www.hp.com/go/insightsoftware/docs.

LSM troubleshooting information is included in the HP Insight Manager 6.3 Software with Logical Server
Management: User Guide. This and other ID docs are available at www.hp.com/go/insightdynamics/docs
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Appendix A: Quiescing services on Source CMS

Prior to stopping the HP Insight Software services and backing up your environment, you must quiesce
Insight Software components. The following actions only need to be performed for components that are
installed and currently in use in your environment.

Note:

The steps might vary slightly depending on the version of software installed on
your system. See the product documentation for your release for additional
information.

1. Ensure all in-progress Insight Dynamics recovery management jobs have completed. You can view the
status of these jobs by selecting Insight Recovery... from the Tools menu in HP SIM. Select the Jobs
tab to view the status of jobs. A job with the In progress icon in the Status column has not completed.

2. Ensure no Insight Dynamics infrastructure orchestration requests are in-progress, paused or scheduled.
You can view the status of Insight Dynamics infrastructure orchestration requests by selecting Insight
Orchestration... from the Tools menu in HP Systems Insight Manager and then selecting the Requests
tab. Click the End Date column name to sort the request list. Requests with an empty End Date have
not completed. If a request is scheduled to run during the upgrade process, you will need to defer the

execution of the request until the upgrade process is complete.

3. Ensure all in-progress logical server jobs have completed before stopping the HP Logical Server
Automation service. Logical server jobs that are in-progress when the service stops will fail. These

jobs must be resubmitted after restarting the Service. You can view the status of logical server jobs by
selecting VSE Management... from the Tools menu in HP Systems Insight Manager. Use the Reports
menu to select the Logical Server Job Status... item. Click the % complete column name to sort the list

of jobs.
4, Ensure all in-progress Virtual Connect jobs have completed. You can view the status of Virtual

Connect jobs by selecting Integrated Consoles=>Virtual Connect Enterprise Manager (VCEM)... from
the Tools menu in HP SIM. Select the Jobs tab to view the status of jobs. Click the End Time column

name to sort the job list. Jobs displaying an empty End Time have not finished.
5. Ensure all in-progress Virtual Machine tasks have completed. You can view the status of Virtual

Machine tasks by selecting View Task Results... from the Tasks & Logs menu in HP SIM. Click the
End Time column name to sort the task list. Tasks displaying an empty End Time have not completed.

6. Ensure all in-progress installation and configuration tasks have completed (for example, Configure and
Repair Agents tasks or Deploy Drivers, Firmware or Agents). You can view the status of the tasks by
selecting View Task Results... from the Tasks & Logs menu in HP SIM. Click the End Time column

name to sort the task list. Tasks displaying an empty End Time have not finished.

If you are using the CMS to manage gWLM on Integrity nodes, you can issue the gwlm history --Flush
command to gather the latest historical data from the gWLM agents before performing a backup. This step

may be skipped if you are not using the CMS to manage gWLM on Integrity nodes.



Appendix B: Stop order of services

The export utility stops services automatically in the following order.

Stop order HP Insight software component Service display name

1 HP Insight Dynamics infrastructure orchestration HP Insight Orchestration

2 HP Insight Dynamics infrastructure orchestration RSCentral

3 HP Insight Dynamics infrastructure orchestration RSIRAS

4 HP Insight Dynamics infrastructure orchestration RSScheduler

5 HP Insight Dynamics configuration management HP Logical Server Automation

6 HP Insight Dynamics configuration management HP Storage Provisioning Manager

7 HP Insight Dynamics configuration management HP Extensible Storage & Server
Adapter

8 HP Insight Dynamics configuration management HP Application Discovery

9 HP Insight Dynamics capacity planning HP Agentless Collection for Linux
Systems

10 HP Insight Dynamics capacity planning HP Agentless Data Collector
Service

11 HP Insight Dynamics — VSE Workload Management for HP Global Workload Manager

HP Integrity servers Central Management Server

12 HP Insight Control server migration HP Insight Control server migration
Application Service

13 HP Insight Control server migration HP Insight Control server migration
Web Service

14 HP Insight Control virtual machine management HP Insight Control virtual machine
management

15 HP Systems Insight Manager HP Systems Insight Manager
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Appendix C: Quick reference of export/import commands for
Cluster CMS

Export parameters are same as for non-cluster CMS setups.
Export:
The export command-line (CLI) command and syntax is:
mxexport [—F <Filename>] [-p password]

Where the parameters are listed in the following:

-f—Optional. Can be used to specify a different filename or path for the export archive. The default file name
is Products.zip and is placed in the <SIM Install Path>\data\configdata-export directory
-p—Optional. Enables the password to be passed in on the command line for non-interactive operations such
as a script. This is the password that will be used to encrypt the exported file, Products.zip. If —p is not
specified, the user is prompted to enter the password in a secure fashion. HP recommends not specifying the
password on the command line. The password must be at least 8 characters long and alphanumeric, but should
not be your domain password.

For example:
mxexport —F c:\export.zip —p somepassword

For more details refer to Running the export utility on the source CMS.
Import:

The import command-line (CLI) command and syntax is:
mximport [-f <filename>] [-p password][-v cluster ip][-n cluster name]

—v—Mandatory. Used to specify the Cluster IP also known as the MSCS cluster virtual server IP address of
the target CMS.

—n—Mandatory. Used to specify the Cluster Name/Host Name also known as Cluster name is the MSCS
cluster virtual server name of the target CMS. If Cluster Name/Host Name is not available then pass Cluster
IP.

Example 1:

The following CLI command is used for importing the data into Cluster CMS setup:

mximport -f<File Name> —p <password> —v <Cluster IP> -n <Cluster Name>

For more details, see Running the import utility on the target CMS.



Appendix D: Partner Services Tool

The partnerservice tool is a batch script located in the Systems Insight Manager installation directory. Before
executing any of the following commands, open a command prompt window and set your directory to the
Systems Insight Manager installation directory.

Partner Service CLI usage

Stopping services
o To stop all partner services, issue the following command:

partnerservice -stop all
o To stop a specific partner service, issue the following command:

partnerservice -stop <partner id>.
For example, partnerservice -stop hpsim

Systems Insight Manager and all other Systems Insight Manager dependent services are stopped.

Starting services
e To start all partner services, issue the following command:

partnerservice -start all
o To start a specific partner service, issue the following command:

partnerservice -start <partner id>.
For example, partnerservice -start hpsim

Systems Insight Manager and all other Systems Insight Manager dependent services are stopped.
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FAQ’s

1. How do I migrate data from HP Insight Software 5.3.1 to HP Insight Software 6.3?

— Answer: Before the migration process begins, the source CMS must be upgraded to HP Insight Software
6.3. For more details about the upgrade process, refer to Upgrading to version 6.3 or installing migration
software.

2. How do I selectively migrate components to a target CMS machine from a source 6.3 CMS with HP
Insight Software?

— Answer: For example, if you want to migrate data for only HP Insight Control virtual machine
Management, then retain vmm_migration.xml and hpsim_migrate.xml in
[HPSIM]\config\migration and remove (backup before removing) other XML’s before
exporting/importing.

— While selectively migrating components, all dependant components must be migrated. Ensure the
components to be migrated selectively are installed and the corresponding XML’s are present during
export and import. Required dependant component XML’s are listed in the following table.

— The table lists the XML files to be present at [HPSIM]\config\migration, to selectively migrate
data for a component

Note:
While selectively migrating, ensure the components selected for migration are
installed in target CMS.

Note:
If the source CMS had IRSA installed and configured in it, then the target CMS
should also have IRSA installed and configured for successful import.




Component name

XML files to be present at [HPSIM]\config\migration

Component XML

Required depended component XML’s

HP Systems Insight Manager

hpsim_migrate.xml

None

HP Insight Control virtual machine management

vmm_migration.xml

hpsim_migrate.xml

HP Insight Control performance management

PMP_Muigration.xml

hpsim_migrate.xml
vmm_migration.xml

HP Insight Control power management

ipm_migration.xml

hpsim_migrate.xml

HP Insight Managed System Setup Wizard

MSSW_migration.xml

hpsim_migrate.xml

HP Virtual Connect Enterprise Manager

vcem_migration.xml

hpsim_migrate.xml,
vcem_migration.xml
vmm_migration.xml

HP Logical Server Automation

Ismmigration.xml

hpsim_migrate.xml
vmm_migration.xml
vcem_migration.xml

HP Insight Recovery software

hpir.xml

Ismmigration.xml
hpsim_migrate.xml

HP Insight Global Workload Manager

gwlmmigration.xml

hpsim_migrate.xml

HP Insight Capacity Advisor

CapacityAdvisor.xml

gwlmmigration.xml

hpsim_migrate.xml

HP Application Discovery

ApplicationDiscovery.xml

gwlmmigration.xml

hpsim_migrate.xml

HP Insight Orchestration software

HP10.xml
HPIOAux.xml

HPIOP2.xml

Ismmigration.xml
hpsim_migrate.xml

vmm_migration.xm
|

vcem_migration.xml
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Troubleshooting

Scenario 1: Out of memory error
When does this happen?

In rare occasions, CMSs with a large amount of data, you may observe an Out of Memory error.
Solution

Edit the mxexport.bat/mximport.bat file to increase the memory allocated to the export/import
processes in the Systems Insight Manager installation bin directory. For example, C:\program
files\HP\Systems Insight Manager\bin edit mxexport.bat with any text editor. Change the
line that starts with java and add —Xmx1024m or larger value. The line should look like the
following.

mxexport.bat:

"0BJAVA%" —Xmx1024m -cp %MYPT% com.hp.mx.migration.cli.CLIWrapper mxexport
%*
mximport._bat:

"0BJAVA%" -Xmx1024m -cp %MYPT% com.hp.mx.migration.cli.CLIWrapper mximport

%*
Scenario 2: An export error for one or more plugins occurs with a message
like “No database connection returned for”

c:\mxexport

- No database connection returned for Ism

- No database connection returned for Ism

- Error occurred during the execution of Ismmigration

- No database connection returned for capad

- No database connectino returned for capad

- Error occurred during the execution of Capacity Advisor

- No database connection returned for amgr

- No database connectino returned for amgr

- Error occurred during the execution of ApplicationDiscovery

Solution:
This issue happens because those products try to get a database connection at the same time. To fix that,

we’ve followed Microsoft advice that says to try the connection again.

So, in case of failures, a customized set of retry values could be configured. To do that, the customer needs to
create a file named ‘dmt_db.properties’ under <VSE_INSTALL_DIR> and add the following properties:

MAX_GET_CONNECTION_RETRIES

SLEEP_TIME_BETWEEN_RETRIES

Where

MAX_GET_CONNECTION_RETRIES = maximum number of attempts we will keep trying to get a valid
database connection. The current default value is 10

And

SLEEP_TIME_BETWEEN_RETRIES = maximum amount of time we wait between retries attempts. In other
words, the program will randomly wait from 0 to SLEEP_TIME_BETWEEN_RETRIES milliseconds. The
current default time is 20000 milliseconds.

The customer may want to try higher configuration values, like the following:
MAX_GET_CONNECTION_RETRIES=20



SLEEP_TIME_BETWEEN_RETRIES=30000

Those configurations may increate the time to execute the export operation but will increase the success
chance to get a valid database connection.

Scenario 3: An export error for one or more plugins occurs
c:\mxexport

Warning! Export is not completely successful. Some errors are bypassed
forcibly.

The exported data file is C:/Program Files/HP/Systems Insight
Manager/data/configdata-export\Products.zip.

Solution:

Save the console output to a *.txt file and call support.

Scenario 4: The export or import includes all products, but only the HP SIM
data is required

When does this happen?

By default the data migration tool exports installed products using a set of XML configuration files. The same
applies to the import, on import both the export file and the set of installed components is examined to pull the
common set of data from the exported file.

Solution

You can import only Systems Insight Manager data, or export only HP SIM data. To do this, navigate to the
installation directory and locate the config\migration folder. Delete (or move to a new location) all XML files
except hpsim_migrate.xml on both the source and target CMS systems.

Scenario 5: Invalid drive specification error message
Verify the following:

1. Ensure SQL service account is configured to run as a domain user or administrator user.

2. Ensure on target CMS, permissions are set on folder <HPSIM installation directory>\Systems Insight
Manager\data\configdata-import to full control for authenticated users.

Ensure all the steps are followed as specified at Step 2: Configuring remote database access for the
import operation to the target CMS.

Scenario 6: Power Management data not exported

To minimize any power consumption history loss after migration, ensure that you have completed a full
power-data collection for all systems immediately prior to the migration. Power data collection can be
initiated using the Refresh Data option on the Power/Thermal data reports page for a selected group of
systems.

If you attempt to execute the mxexport command on a system on which power management has not been
enabled or has not collected any power history data, the following warning message appears:

Warning! Plugin ipm encountered problems during export. Its data is not
exported.

Suggested action: No action required.
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Scenario 7: Import failure: gWLM service fails to stop
When does this happen?

The gWLM property com.hp.gwlm.security.virtualLocalHostName=SIMvirtualserverlP in ~\Virtual Server
Environment\conf\gwlmagent.properties has incorrect SIMvirtualserverIP IP Address, where
SIMvirtualserverlP is “virtual server IP address of HPSIM” (also known as MSCS cluster virtual server IP
address).

Error observed during this scenario

1. Import fails on the target machine with console error:

Extracting the zip file c:\export.zip

Service is running for plugin gwlm

02 Sep 2010 15:37:58,510 INFO [HPSIM_DEBUG] [CLIUtil-5] Service is
running for

plugin gwlm

WARNING! Service is running for the following plug-ins: GWLM.
Please stop all services and restart the import function..

02 Sep 2010 15:38:02,408 INFO [HPSIM_DEBUG] [MigrationManager-5]
Import Failed.

Error occurred while importing data. Import failed.
02 Sep 2010 15:38:02,411 INFO [HPSIM_DEBUG] [CLIUtil-5]
Error occurred while importing data. Import failed.
02 Sep 2010 15:38:02,412 INFO [HPSIM_DEBUG] [CLIUtil-5]
02 Sep 2010 15:38:02,412 INFO [HPSIM_DEBUG] [CLIUtil-5]

V:\Program Files\HP\Systems Insight Manager>

Note:

The gWLM Service seems to have stopped but it would have failed to stop. The
logs at ~\Virtual Server Environment\logs\hp_gwlm_service
indicate that the service failed to stop.

2. gWLM log file at: ~\Virtual Server Environment\logs\gwlmcmsd. log, has an error
message as in the following example:

Sep 16, 2010 18:30:58 coltllb.fc.hp.com: SEVERE [10] Error starting
CMS daemon: java.rmi.ServerException: RemoteException occurred in
server thread; nested exception is:

Java.rmi.AccessException: Registry.Registry.rebind disallowed;
origin /15.146.233.1 is non-local host.

Make sure C:\Program Files\HP\Virtual Server
Environmentvseinitconfig has been run after gWLM installation or
upgrade.

Solution

In multi homed networks, ensure gWLM property
com.hp.gwlm.security.virtualLocalHostName=<SIMvirtualserverlIP> in file
~\Virtual Server Environment\conf\gwlmagent.properties has the correct
SIMvirtualserverlP.

Where SIMvirtualserverlP is Cluster IP also known as MSCS cluster virtual server IP address.

In case <SIMvirtualserverlP> ismissing or is NOT Cluster IP also known as MSCS cluster virtual
server IP address, add/modify it to Cluster IP. To enable this change restart gWLM and SIM services.



Scenario 8: Logical servers not activated after import

By default, the migration process activates any logical servers that were activated on the source CMS. Other
appropriately configured logical servers can be activated post migration. If you encounter problems activating
logical servers after migration is complete, see the logical servers troubleshooting information in the HP
Insight Virtualization Manager Software with Logical Server Management: User Guide. This and other
Insight Dynamics manuals are available at www.hp.com/go/insightdynamics/docs.
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